
National Instruments™, NI™, ni.com™, and SCXI™ are trademarks of National Instruments Corporation. Product and company names mentioned herein
are trademarks or trade names of their respective companies. For patents covering National Instruments products, refer to the appropriate location:
Help»Patents in your software, the patents.txt file on your CD, or ni.com/patents.

371181A-01 © 1993–2002 National Instruments Corp. All rights reserved. February 2002

INSTALLATION GUIDE

SCXI -1351 ONE-SLOT CABLE EXTENDER
This guide describes how to install the National Instruments SCXI-1351
one-slot cable extender in an SCXI system.

The SCXI-1351 extends the pinout from a 100- or 50-pin digital I/O (DIO)
data acquisition (DAQ) device to one or more SCXI modules. The
SCXI-1351 is intended for use with the SCXI-1181 module for custom
signal conditioning, but you can use it with some other SCXI modules.

What You Need To Get Started
To set up and use the SCXI-1351, you need the following items:

❑ Computer

❑ One or more SCXI-1351 one-slot cable extenders

❑ One or more SCXI modules

❑ SCXI chassis

❑ 100- or 50-pin DIO DAQ device

❑ One of the following:

– NB5, NB6, or R1005050 cable for a 100-pin DIO device

– NB1 or R5050 cable for a 50-pin DIO device

❑ SCXI-1351 One-Slot Cable Extender Installation Guide

❑ Small flathead screwdriver

❑ Two small screws

™
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Conventions
The following conventions are used in this guide:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.

Safety Information
The following section contains important safety information that you must
follow when installing and using the product.

Do not operate the product in a manner not specified in this document.
Misuse of the product can result in a hazard. You can compromise the
safety protection built into the product if the product is damaged in any
way. If the product is damaged, return it to NI for repair.

Do not substitute parts or modify the product except as described in this
document. Use the product only with the chassis, modules, accessories, and
cables specified in the installation instructions. You must have all covers
and filler panels installed during operation of the product.

Do not operate the product in an explosive atmosphere or where there may
be flammable gases or fumes. Operate the product only at or below the
pollution degree stated in the Specifications section. Pollution is foreign
matter in a solid, liquid, or gaseous state that can reduce dielectric strength
or surface resistivity. The following is a description of pollution degrees:

• Pollution degree 1 means no pollution or only dry, nonconductive
pollution occurs. The pollution has no influence.

• Pollution degree 2 means that only nonconductive pollution occurs in
most cases. Occasionally, however, a temporary conductivity caused
by condensation must be expected.
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• Pollution degree 3 means that conductive pollution occurs, or dry,
nonconductive pollution occurs that becomes conductive due to
condensation.

Clean the product with a soft nonmetallic brush. Make sure that the product
is completely dry and free from contaminants before returning it to service.

You must insulate signal connections for the maximum voltage for which
the product is rated. Do not exceed the maximum ratings for the product.
Remove power from signal lines before connecting them to or
disconnecting them from the product.

Operate this product only at or below the installation category stated in the
Specifications section.

The installation category for this device, installation category I, is for
measurements performed on circuits not directly connected to MAINS1.
This category is a signal level such as voltages on a printed wire board
(PWB) on the secondary of an isolation transformer.

Examples of installation category I are measurements on circuits not
derived from MAINS and specially protected (internal) MAINS-derived
circuits.

1 MAINS is defined as the electricity supply system to which the equipment concerned is designed to be connected either for
powering the equipment or for measurement purposes.
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Connecting the SCXI-1351
The SCXI-1351 consists of a mounting bracket with a short 50-pin ribbon
cable, a mounting bracket connector, a female rear connector, and a male
breakout connector. Figure 1 shows the SCXI-1351 with the cable
extended and the SCXI-1351 with the cable folded into place and ready for
installation.

Figure 1. SCXI-1351 Extended and Folded Views

1 Female Rear Connector
2 Male Breakout Connector

3 Mounting Bracket Connector
4 Mounting Bracket
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Choosing Cable Connectors
The type of DIO device, SCXI module, and the operation mode you use
determine which cable connector you should use to connect the SCXI-1351
to the DIO device. The NB5, NB6, and R1005050 cables have a 100-pin
connector at one end and two 50-pin connectors at the other end. One
50-pin connector is labeled Positions 1–50, and the other is labeled
Positions 51–100. The NB1 and R5050 cables have two 50-pin connectors.
Table 1 shows which cable connector you should use to connect to the
SCXI-1351.

Note If the module that you are using is not listed in this table, please refer to the NI Web
site at ni.com/support for technical support.

Table 1. Cabling Options

Module Type SCXI Module 100-Pin 50-Pin

Relay SCXI-1160 Positions 1–50 Positions 1–50

SCXI-1161 Positions 1–50 Positions 1–50

SCXI-1163R Positions 1–50 Positions 1–50

DIO SCXI-1162 Serial mode: positions 1–50;
Parallel mode: either

Positions 1–50

SCXI-1163 Serial mode: positions 1–50;
Parallel mode: either

Positions 1–50

Breadboard SCXI-1181 Either Positions 1–50
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Installing the SCXI-1351 One-Slot Cable Extender
The SCXI-1351 installation procedures differ depending on the type of
DIO device, SCXI modules, and operation mode you use. Refer to Figure 2
for the basic installation procedure. Specific installation procedures follow
Figure 2.

Figure 2. SCXI-1351 Installation

1 SCXI Module Rear Signal Connector
2 Mounting Bracket Connector
3 Mounting Bracket

4 Female Rear Connector
5 Male Breakout Connector
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Installing the SCXI-1351 with a 100-Pin DIO Device in Serial Mode
Perform the following steps to install the SCXI-1351 with a 100-pin DIO
device in serial mode:

1. Power off the computer and SCXI chassis.

2. Install the SCXI module, following the instructions in the module user
manual.

3. Connect the male breakout connector of the SCXI-1351 to the
appropriate 50-pin cable connector.

4. Plug the mounting bracket connector of the SCXI-1351 into the
module rear signal connector. Make sure the alignment tab on the
bracket enters the upper device guide of the chassis.

5. Screw the mounting bracket to the threaded strips in the rear of the
chassis to secure the SCXI-1351 in place.

6. Connect the 100-pin cable connector to the DIO device.

Note Leave the female rear connector without a connection.

Installing the SCXI-1351 with a 100-Pin DIO Device in Parallel Mode
Perform the following steps to install the SCXI-1351 with a 100-pin DIO
device in parallel mode:

1. Power off the computer and SCXI chassis.

2. Install the two SCXI modules, following the instructions in the module
user manual.

3. Connect the male breakout connector of the SCXI-1351 to a 50-pin
cable connector. Connect the male breakout connector of another
SCXI-1351 to the other 50-pin cable connector.

4. Plug the mounting bracket connector of each SCXI-1351 into the rear
signal connector of each module. Make sure the alignment tab on the
brackets enter the upper device guide of the chassis.

5. Screw the mounting brackets to the threaded strips in the rear of the
chassis to secure the SCXI-1351 one-slot cable extenders in place.

6. Connect the 100-pin cable connector to the DIO device.

Note Leave the female rear connector without a connection.
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Installing the SCXI-1351 with a 50-Pin DIO Device
Perform the following steps to install the SCXI-1351 with a 50-pin device:

1. Power off the computer and SCXI chassis.

2. Install the SCXI module, following the instructions in the module user
manual.

3. Connect the male breakout connector of the SCXI-1351 to a 50-pin
cable connector.

4. Plug the mounting bracket connector of the SCXI-1351 into the
module rear signal connector. Make sure the alignment tab on the
bracket enters the upper device guide of the chassis.

5. Screw the mounting bracket to the threaded strips in the rear of the
chassis to secure the SCXI-1351 in place.

6. Connect the other 50-pin connector of the cable to the DIO device.

Note Leave the female rear connector without a connection.

Installing the SCXI-1351 with Multiple SCXI-1181 Modules
Perform the following steps to install the SCXI-1351 with multiple
SCXI-1181 modules. Refer to Figure 3 for an illustration of this installation
procedure.

1. Power off the computer and SCXI chassis.

2. With the front of the chassis facing you, install the SCXI-1181
modules in adjacent slots starting on the right, following the
instructions in the module user manual.

3. Connect the male breakout connector of the SCXI-1351 to a 50-pin
cable connector.

4. If you have more than one SCXI-1351, connect the female rear
connector of the SCXI-1351 to the male breakout connector of the next
SCXI-1351. Repeat this step for each SCXI-1351 you want to install.

5. With the rear of the chassis facing you, plug the mounting bracket
connectors of the SCXI-1351 one-slot cable extenders into the rear
signal connectors of the modules, starting with the left-most module.
Make sure the alignment tab on the bracket enters the upper device
guide of the chassis.

6. Screw the mounting brackets to the threaded strips in the rear of the
chassis to secure the SCXI-1351 one-slot cable extenders in place.
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7. Connect the female rear connector of the last SCXI-1351 to the rear
signal connector of the right-most module.

8. If you have a 100-pin DIO device, connect the 100-pin cable connector
to the device. If you have a 50-pin DIO device, connect the remaining
50-pin cable connector to the device.

Figure 3. Multiple SCXI-1351 Connection

1 Female Rear Connector
2 Male Breakout Connector

3 Mounting Bracket Connector
4 Female Rear Connector to SCXI-1181 Module
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Specifications

Maximum Working Voltage
Maximum working voltage refers to the signal voltage plus the
common-mode voltage.

Channel-to-earth .....................................30 VAC, ±30 VDC,
installation category I

Channel-to-channel.................................30 VAC, ±30 VDC,
installation category I

Environmental
Operating temperature ............................0 to 50 °C

Storage temperature ................................–20 to 70 °C

Humidity .................................................10 to 90% RH, noncondensing

Maximum altitude...................................2000 meters

Pollution degree (indoor use only) .........2

Safety
The SCXI-1351 meets the requirements of the following standards for
safety and electrical equipment for measurement, control, and laboratory
use:

• EN 61010-1:1993/A2:1995, IEC 61010-1:1990/A2:1995

• UL 3111-1:1994

• CAN/CSA c22.2 no. 1010.1:1992/A2:1997
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Technical Support Resources

NI Web Support
NI Web support is your first stop for help in solving installation,
configuration, and application problems and questions. Online
problem-solving and diagnostic resources include frequently asked
questions, knowledge bases, product-specific troubleshooting wizards,
manuals, drivers, software updates, and more. Web support is available
through the Technical Support section of ni.com.

Worldwide Support
NI has offices located around the world to help address your support needs.
You can access our branch office Web sites from the Worldwide Offices
section of ni.com. Branch office Web sites provide up-to-date contact
information, support phone numbers, e-mail addresses, and current events.

If you have searched the technical support resources on our Web site
and still cannot find the answers you need, contact your local office or NI
corporate. For telephone support in the United States, dial 512 795 8248.
For telephone support outside the United States, contact your local branch
office:

Australia 03 9879 5166, Austria 0662 45 79 90 0, Belgium 02 757 00 20,
Brazil 011 3262 3599, Canada (Calgary) 403 274 9391,
Canada (Montreal) 514 288 5722, Canada (Ottawa) 613 233 5949,
Canada (Québec) 514 694 8521, Canada (Toronto) 905 785 0085,
China (Shanghai) 021 6555 7838, China (ShenZhen) 0755 3904939,
Czech Republic 02 2423 5774, Denmark 45 76 26 00, Finland 09 725 725 11,
France 01 48 14 24 24, Germany 089 741 31 30, Greece 30 1 42 96 427,
Hong Kong 2645 3186, India 91 80 535 5406, Israel 03 6393737, Italy 02 413091,
Japan 03 5472 2970, Korea 02 3451 3400, Malaysia 603 9596711,
Mexico 001 800 010 0793, Netherlands 0348 433466, New Zealand 09 914 0488,
Norway 32 27 73 00, Poland 0 22 3390 150, Portugal 351 210 311 210,
Russia 095 238 7139, Singapore 2265886, Slovenia 386 3 425 4200,
South Africa 11 805 8197, Spain 91 640 0085, Sweden 08 587 895 00,
Switzerland 056 200 51 51, Taiwan 02 2528 7227,
United Kingdom 01635 523545
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